[image: image1.jpg]



Fiscal Year 2014–15
Principal Apportionment

Data Collection Software 

Version 14.00



User Guide

December 2014





California Department of Education

School Fiscal Services Division
1430 N Street


Sacramento, CA  95814 
Table of Contents

11.0
Introduction


11.1
Intended Audience


11.2
Related Documents


11.3
System Requirements


11.4
Document Conventions


32.0
Data Collection Software


32.1
COE Instructions


52.1.1
County Office of Education Entry Screens


62.1.2
County Program Charter School Entry Screens


62.1.3
Tax Entry Screens


72.2
School District Instructions


82.2.1
School District Attendance Entry Screens


102.3
Charter School Instructions


112.3.1
Charter School Attendance Entry Screens


122.4
SELPA Instructions


132.4.1
SELPA Entry Screens


142.5
County Auditor Instructions


152.5.1
County Auditor Taxes Entry Screen


163.0
Installing the Principal Apportionment Software


163.1
Installation Procedures


173.2
Setting Compatibility Mode


183.3
Version Checking


194.0
Basic Operating Procedures


194.1
Adding a New User


224.2
Logging On


234.3
Getting The Latest LEA Updates


244.4
Accessing Help


264.5
Navigating Main Menus


264.5.1
Main Menu Grids


284.5.2
Main Menu Commands


314.5.3
Selecting and Opening an Entry Screen


324.5.4
Selecting LEAs and Entry Screens for Printing and Exporting to an ASCII (Text) File


344.6
Entering Data


344.6.1
Entry Screen Commands


364.6.2
Entering Data into Single Record Entry Screens


374.6.3
Entering Data into Multiple Record Entry Screens


394.6.4
Switching Between Tabbed and Drop-Down Menus


414.7
Resizing Windows


425.0
Edit Check Reports


456.0
Correcting Data from a Prior Period


456.1
Corrected Period Main Menu


476.2
Correcting Data


496.3
Saving Data in P-2 and Annual Reporting Periods


507.0
Importing and Exporting


507.1
Importing Data Files


507.1.1
Importing ASCII Files


527.1.2
Importing Certified Data Files


537.2
Exporting Data Files


537.2.1
Selecting Data to Export


547.2.2
Exporting ASCII Files


557.2.3
Exporting Certified Data Files


598.0
Submitting Certified Data Files


598.1
Sending Certified Files to the COE


598.2
Uploading Certified Data


639.0
Printing Data


639.1
Printing Reports from an Entry Screen


639.2
Printing Reports from the Main Menu




List of Figures

17Figure 1: Compatibility Mode Window


18Figure 2: Sample Version Number On The Logon Screen


19Figure 3: New User Screen


20Figure 4: PASE Listserv Blank Email


22Figure 5: Main Menu


23Figure 6: Importing Data For Get Latest Screen


25Figure 7: Help


31Figure 8: Sample Entry Screen


35Figure 9: Sample Notes Window


36Figure 10: Sample Single Record Entry Screen


37Figure 11: Sample Multiple Record Entry Screen


38Figure 12: Sample Add New Record Screen


38Figure 13: Sample Entry Screen After Adding A New Record


40Figure 14: Entry Screen Tabs


41Figure 15: Entry Screen Drop-Down Menu


42Figure 16: Edit Check Process Message Box


43Figure 17: Sample Edit Check Report


45Figure 18: Main Menu Screen For Corrected Periods


48Figure 19: Correction Reason Screen


50Figure 20: Importing ASCII Data Screen


52Figure 21: Importing Certified Data Screen


53Figure 22: Export Certified Window


54Figure 23: Export Certified Window With All Districts Selected


58Figure 24: Sample Data Modification Window


60Figure 25: Submit Datafile Window


60Figure 26: Select Datafile to Submit Window


61Figure 27: Enter Password Message Box


61Figure 28: Incorrect Password Message Box


61Figure 29: Uploading Confirmation Message Box


62Figure 30: Operation Complete Status Window




List of Tables

5Table 1: County Entry Screens


6Table 2: County Charter School Entry Screens


6Table 3: Tax Entry Screens


9Table 4: School District Attendance Entry Screens


11Table 5: Charter School Attendance Entry Screens


13Table 6: SELPA Entry Screens


15Table 7: County Auditor Taxes Entry Screens


21Table 8: New User Screen Fields


26Table 9: LEA Grid Information


27Table 10: Entry Screens Grid Information


28Table 11: File Menu Commands


30Table 12: Available Tools Menu Commands


34Table 13: File Menu Commands


35Table 14: Note Menu Buttons


37Table 15: Multiple Record Entry Screens Navigation Buttons


44Table 16: Edit Check Report Information


44Table 17: Edit Check Screen Functions


46Table 18: LEA Grid Columns For Corrected Periods


47Table 19: Entry Screen Grid Columns For Corrected Periods


64Table 20: Available Software Reports For Printing (by user group)


65Table 21: Principal Apportionment Software Printed Report Descriptions





1.0 Introduction

1.1 Intended Audience
This document is intended to help local education agencies (LEAs) quickly become familiar with how to use the Principal Apportionment Data Collection Software. Understanding basic Windows functions and procedures, such as clicking, double clicking, right clicking, browsing, etc., will assist you in using this document and software.

1.2 Related Documents

For step-by-step installation instructions, please refer to the Principal Apportionment Data Collection Manual and Tax Software Installation Guide that accompanies this User Guide available at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp.

For more information on how to report data using the software, please refer to the Data Reporting Instruction Manual at located on the Principal Apportionment Data Collection Web page at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp. 
1.3 System Requirements

The installation of the software requires approximately 20–40 MB of hard disk space on Windows based PCs. 
1.4 Document Conventions

This document uses the following conventions to describe functions and procedures in the software: 

	Window Names
	The names of windows, screens, and dialogue boxes use title case, such as:
Save As window
User Information screen

	Commands
	Commands are operations you must follow in order to perform certain functions in the software. Bold face font is used, such as:
Select Print from the File menu
Click the OK button

	Image Names
	Images, or pictures, are described as Figures and use Italic face font, such as: 
Figure 1: Diagram of the data process.

	Important Notes
	Notes include important statements regarding steps you may need to take. They are highlighted in gray, with a black border on the top and bottom, such as:

Note:  Important note here.


2.0 Data Collection Software

The Principal Apportionment Data Collection (PADC) Software is used by county offices of education (COEs), school districts, charter schools, and special education local plan areas (SELPAs) to:

· Enter attendance data for COEs, school districts, and charter schools

· Enter Local Control Funding Formula (LCFF) data

· Enter tax data
· Enter Special Education data
For detailed information on the data entry screens, refer to the Data Reporting Instruction Manual available under the PADC Software Fiscal Year 2014–15 link at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp.

The following subsections in Section 2 describe step-by-step instructions for each local educational agency (LEA) type (COE, school district, charter school, SELPA, and county auditor) to use as a guide to ensure the complete submission of Principal Apportionment data to the California Department of Education. A table is also provided for each LEA type that lists all the data entry screens applicable to that LEA, a summary of the data collected in each screen, and the periods for which the entry screen is available. Sections 3 to 9 of this document provide a user with detailed instructions on how to accomplish the step-by-step instructions listed below.
2.1 COE Instructions
Each COE has local procedures that should be followed to accurately report data in time for each Principal Apportionment period.

To report COE data or data for which the COE is responsible to report (school districts, charter schools, taxes and SELPAs):
1. Install the PADC Software.

2. Add a county office user and login.

3. Select the correct reporting period.

4. Enter COE data in each appropriate entry screen.

5. Import certified school district files and verify their contents.

or
Enter school district data in each appropriate entry screen for every school district in the county.
6. Import certified charter school files and verify their contents.
or

Enter charter school data in each appropriate entry screen for every charter school in the county.
7. Enter school district and county tax data in each appropriate entry screen.

or

Import a certified tax file and verify its contents.

8. Import certified SELPA files and verify their contents. 
or

Enter SELPA data in each appropriate entry screen for each SELPA.
9. Ensure that all data exists for lower-level LEAs by running a Status report.

10. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens, if applicable.

11. Export the data for the COE, county auditor, school districts, charter schools, and SELPAs to a certified data file.

12. Upload the certified data files to the CDE utilizing the Upload Certified Data functionality.

13. Print and sign a COE certification page(s) and retain it for your records.

Optional tasks include:

1. Printing reports for each entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank certifications or certification exception.

2.1.1 County Office of Education Entry Screens

Table 1 displays each county entry screen available to COEs, the type of data that needs to be entered, available periods for data entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Adults in Correctional Facilities (AICF)
	Average daily attendance (ADA) for adults in correctional facilities and certification of LEA’s participation in the AICF program in the prior year.
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	Attendance COE
	ADA for students that generate funding under the Alternative Education Grant [EC 2574(c)(4)(A) or (B)] and other miscellaneous categories.
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	Attendance District Funded County Programs
	ADA reported by a COE by district of residence for students they serve that are not funded through the COE’s Alternative Education Grant. This ADA is credited to the district of residence and included in the district’s Local Control Funding Formula (LCFF) entitlement calculations. Additionally, a COE may enter up to two funding  rates by grade span for each ADA category, by district of residence for the California Department of Education (CDE) to administer the transfer of funds between the district of residence and the COE, provided the district agrees to the transfer. 
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	COE Audit Adjustments to CALPADS Data
	Report enrollment and unduplicated pupil counts changes to a COE’s certified CALPADS data due to an audit finding or auditor letter of concurrence. If pursuant to an auditor’s letter of concurrence, a copy of the letter must be provided to the (CDE) .
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	COE LCFF Adjustments
	Report data for county office of education (COE) local revenue offsets and expenditure reimbursements that continue under the LCFF. 
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	Foster Youth Necessary Small High School
	Number of full-time teachers and ADA for a necessary small high school maintained by a COE for the exclusive purpose of educating foster youth pursuant to EC 42285(b). 
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	SELPA ADA Allocation
	Allocation of SELPA ADA. By allocating the ADA in this entry screen, COEs can credit the ADA to SELPAs where Special Education services were provided.
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Table 1: County Entry Screens

2.1.2 County Program Charter School Entry Screens

Table 2 displays each charter school operating a county program pursuant to Education Code Section 47605.5 entry screen available for the charter school, the type of data that needs to be entered, available periods for data entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Attendance Charter Funded County Programs
	Average daily attendance (ADA) and days of operation for charters schools established pursuant to EC 47605.5 that serve pupils for whom the COE would otherwise be responsible for providing direct education and related services.
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	Attendance COE Charter School
	ADA and days of operation for charter schools established pursuant to EC 47605.5 that have students that generate funding pursuant to EC 2574 (c)(4)(A) or EC 2574 (c)(A)(B) should use this screen. 
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Table 2: County Charter School Entry Screens 
2.1.3 Tax Entry Screens

Table 3 displays the Tax entry screens available to users for the county office user group. 

Note:
County Superintendents must submit Miscellaneous Funds information, even if the amount is zero.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Miscellaneous Funds
	Funds from royalties, bonuses, and payments in lieu of taxes.
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	Special Education Tax Allocation
	Allocate a percentage of tax receipts to each SELPA Administrative Unit to which the COE belongs.
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	Taxes
	School district and county taxes.
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Table 3: Tax Entry Screens

2.2 School District Instructions
Each school district has local procedures that should be followed to accurately report data in time for each Principal Apportionment period.

To report the school district’s data or data for which the school district is responsible for:

1. Install the PADC Software.

2. Add a school district user and login.

3. Select the correct reporting period.

4. Enter school district data in each appropriate entry screen for the appropriate district.

or

Import a certified school district file and verify its contents.

5. For charter schools that the school district has authorized, enter charter school data in each appropriate entry screen for the appropriate charter.

or

Import a certified charter school file and verify its contents.

6. If the school district is a SELPA Administrative Unit, enter SELPA infant data in each appropriate entry screen.

or

Import a certified SELPA file and verify its contents.

7. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens, if applicable.

8. Export the data for the school district, charter schools, and SELPAs to a certified data file and send the file to your COE.

9. Print and sign the certification page(s) and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank certifications or certification exception.

2.2.1 School District Attendance Entry Screens
Table 4 displays each available school district entry screen, the type of data that needs to be entered, available reporting periods for data entry, and whether the entry screen allows for multiple records.
	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Adults in Correctional Facilities (AICF)
	Average daily attendance (ADA) for adults in correctional facilities and certification of LEA’s participation in the AICF program in the prior year.
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	Annual Migrant ADA Increase
	Annual Migrant ADA is attributable to pupils of migrant agricultural workers in accordance with EC 41601.5.  LEA’s can submit data to have its Local Control Funding Formula funding calculated utilizing Annual ADA in lieu of P-2 ADA and certify the increase from P-2 ADA to Annual ADA. 
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	Attendance School District 
	Report ADA by category and grade span for pupils enrolled in the school district and not reported in the Attendance Supplement, Attendance Basic Aid Choice/Court Ordered Voluntary Pupil Transfer, or Attendance Basic Aid Open Enrollment. Also report P-2 ADA adjustments for the prior year and other miscellaneous categories. 
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	Attendance Supplement School District 
	Report ADA by category and grade span for students residing outside a district with 25% or more P.L. 874 students (EC Section 46610). Capistrano Unified School District (Orange County) is the only school district that can access this entry screen.
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	Attendance Basic Aid Choice/Court-Ordered Voluntary Pupil Transfer
	Report inter-district transfer ADA by category and grade span by district of residence for pupils attending the district pursuant to the District of Choice program (EC 48310) or as part of the Court-Ordered Voluntary Pupil Transfer program pursuant to EC 41544. 
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	Attendance Basic Aid Open Enrollment
	Report inter-district transfer ADA by category and grade span by district of residence for a pupil that attends the district for two or more years pursuant to the open enrollment provisions (EC 48359.5).
	[image: image84.jpg]



	[image: image85.jpg]



	[image: image86.jpg]



	[image: image87.jpg]



	[image: image88.jpg]



	[image: image89.jpg]




	Class Size Penalties SD
	School districts can elect to transfer funding for ADA served by a county office of education (COE) for which the LCFF funds flow to the district of residence. A district may choose to select some, none, or all of the COEs that serve its students.
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	County Served District Funded ADA Transfer Selection 
	Allows a school district to select one or more county offices of education to re-automate the transfer of funds for county served ADA through the Principal Apportionment. This screen is optional.
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	Necessary Small Elementary School 
	Number of full-time teachers and ADA for each necessary small elementary school. Complete prior year fields only if the school district did not submit the number of full-time teachers or ADA in the prior year.
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	Necessary Small High School 
	Number of full-time teachers and ADA for each necessary small high school. Complete prior year fields only if the school district did not submit the number of full-time teachers or ADA in the prior year.
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	Necessary Small School Funding Selection
	Select a school to be funded through the Necessary Small School Funding formula.
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	Necessary Small School Certification Selection
	Select and certify schools for possible participation in the Necessary Small School funding program.
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	School District Audit Adjustments to CALPADS Data
	Report enrollment and unduplicated pupil counts changes to a school district’s certified CALPADS data due to an audit finding or auditor letter of concurrence. If pursuant to an auditor’s letter of concurrence, a copy of the letter must be provided to the California Department of Education.
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Table 4: School District Attendance Entry Screens

2.3 Charter School Instructions
Each charter school has local procedures that should be followed to accurately report data in time for each Principal Apportionment period. 

To report the charter school data:

1. Install the PADC Software.

2. Add a charter school user and login.

3. Select the correct reporting period.

4. Enter charter school data in each appropriate entry screen.

5. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens, if applicable.

6. Export the data for the charter school to a certified data file and send the file to your school district or COE.

7. Print and sign the certification page(s) and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Printing blank certifications or certification exception.

2.3.1 Charter School Attendance Entry Screens

Table 5 displays each entry screen available to charter schools, the type of data that needs to be entered, the periods the entry screen is available for entry, and whether the entry screen allows for multiple records.
	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Charter Status
	Information about the current status of the charter school to allow the California Department of Education (CDE) to appropriately calculate the charter school’s funding.
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	Attendance Charter School 
	Report average daily attendance (ADA) and days of operation by category and grade span. Also report ADA for other miscellaneous categories.
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	Attendance Charter School – All Charter District
	Report resident and non-resident ADA and days of operation by category and grade span. Also report ADA for the miscellaneous categories. 
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	Attendance Charter Funded County Programs
	Report ADA and days of operation for charters schools established pursuant to EC 47605.5 that serve pupils for whom the COE would otherwise be responsible for providing direct education and related services.
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	Attendance COE Charter School
	Report ADA and days of operation for charter schools established pursuant to EC 47605.5 that have students that generate funding pursuant to EC 2574 (c)(4)(A) or (B) should use this screen. 
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	Basic Aid Supplement Charter School
	Reported ADA will be used to determine if the sponsoring district of a charter school is eligible for additional funding pursuant to EC 47663. For the purposes of this entry screen, “basic aid school district” means a school district that does not receive from the state an apportionment of state funds pursuant to EC Section 42238.02(o).
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	Charter School Audit Adjustments to CALPADS
	Report enrollment and unduplicated pupil counts changes to a charter school’s certified CALPADS data due to an audit finding or auditor letter of concurrence. If pursuant to an auditor’s letter of concurrence, a copy of the letter must be provided to the CDE.
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	Charter School Physical Location
	School district(s) in which the charter school is physically located or has a school facility. All charters will report except for charters in all-charters districts.
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Table 5: Charter School Attendance Entry Screens

2.4 SELPA Instructions
Each SELPA Administrative Unit (AU) and local educational agency (LEA) has local procedures that should be followed to accurately report data for each Principal Apportionment period.

To report the data for SELPA AUs and LEAs:

1. Install the PADC Software.

2. Add a SELPA user and login.

3. Select the correct reporting period.

4. Enter SELPA Administrative Unit and LEA data in each appropriate entry screen.

5. Ensure that the data have no errors using the Check/Save utility in the appropriate entry screens, if applicable.

6. Export the data to a certified data file.

7. Send the certified data file to your COE via e-mail, FTP, or on a floppy disk through the postal service.

8. Print and sign the certification page(s) and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank certifications or certification exception.

2.4.1 SELPA Entry Screens

Table 6 displays each SELPA entry screen available to users from the county office, school district, and SELPA user groups, the type of data that needs to be entered, the periods the entry screen is available for entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Infant Funding
	Report total infant units, classified and certificated employee data, and infant unit transfers within SELPA.
	[image: image158.jpg]



	[image: image159.jpg]



	[image: image160.jpg]



	
	[image: image161.jpg]



	[image: image162.jpg]




	Extraordinary Cost Pool Claim
	Extraordinary cost pool claim data.
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	Necessary Small SELPAs Extraordinary Cost Pool Claim for Mental Health Services
	Claim data for necessary small SELPAs as defined in EC 56212 for extraordinary costs associated with educationally related mental health services including out-of-home residential services.
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Table 6: SELPA Entry Screens

2.5 County Auditor Instructions
Each county auditor has local procedures that should be followed to accurately report taxes in time for each Principal Apportionment period.

To report the taxes for the county office of education and all school districts:

1. Install either the Principal Apportionment Data Collection or Tax Software.

2. Add a county auditor user and login.

3. Select the correct reporting period.

4. Enter school district and county tax data in each appropriate entry screen by selecting the Tax Type (County or District) from the drop-down box.

5. Export the data to a certified data file.

6. Send the certified data file to your COE.

7. Print and sign the certification page and send it to your COE.

Optional tasks include:

1. Printing reports for the entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank certifications, summaries, or certification exceptions.
Note:
The Tax Software package can be downloaded separately but the data elements reported through the Tax Software may also be accessed through the Principal Apportionment Data Collection Software. If you install the Principal Apportionment Data Collection Software package, it is not necessary to separately install the Tax Software package. County offices should install the Principal Apportionment Data Collection Software package. However, because First Principal taxes are due to the California Department of Education before the release of the Principal Apportionment Data Collection Software, some county offices may choose to install the Tax Software package as well. County auditors that report taxes directly should install the Tax software package.  

2.5.1 County Auditor Taxes Entry Screen

The following table displays the entry screen available to users from the county auditor user group 
(Table 7).
	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Taxes
	School district and county taxes.
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Table 7: County Auditor Taxes Entry Screens 
3.0 Installing the Principal Apportionment Software

This chapter gives an overview of the tasks that must be completed in order to properly install the Principal Apportionment Data Collection (PADC) Software. For specific installation instructions, please refer to the Principal Apportionment Data Collection and Tax Software Installation Guide available at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp.
3.1 Installation Procedures

Installing the software from the Internet.

1. Download the software for the current fiscal year from the Internet at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp to your desktop. Select the PADC Software Fiscal Year 2014–15 link.
2. Find and double-click the software executable file downloaded from the Internet.

3. The InstallShield Wizard window displays.

4. The Preparing to install window displays.

5. The Welcome window displays.

6. Click Next. The Customer Information window displays. Enter your information.
7. Click Next. The Destination Folder Program window displays.

8. Click Next. The Database Folder Program window displays.
9. Click Next. The Ready to Install the Program window displays.

10. Click Install. The progress meter displays the installation status.

11. When the installation is complete, the Installation Completed window displays, and the dialog box shows whether or not the software installed successfully.

12. Click Finish.

Note:
You may be asked to restart your computer. Click Yes. After the computer restarts, you can start using the Software.

3.2 Setting Compatibility Mode

After installing the PADC Software, right click on the shortcut on your desktop) to set the compatibility mode to Windows XP (Service Pack 3) as shown in Figure 1. If you are using Windows XP your system should already be set to Windows XP. However, if you are using Windows 7 we strongly recommend you run the PADC Software in this mode to alleviate errors caused by compatibility issues between Windows 7 and the PADC Software.
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Figure 1: Compatibility Mode Window 
3.3 Version Checking

Version checking is an important method used to ensure the correct version of the software is being used. When you open the software, the Logon screen displays the version number (Figure 2). Check the version number on the CDE Web site at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp.
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Figure 2: Sample Version Number On The Logon Screen

4.0 Basic Operating Procedures

4.1 Adding a New User

You can add one or more users to the system. Add a user by clicking the New User button in the Logon screen. After you click the New User button, the New User screen displays (Figure 3).
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Figure 3: New User Screen
From the new user screen, you can now subscribe to the Principal Apportionment and Special Education PASE Listserv to stay informed of apportionment information. Click on the join-pase-contacts@mlist.cde.ca.gov link and send a blank email (Figure 4).
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Figure 4: PASE Listserv Blank Email 
Some fields are not active until after you select other fields. For example, the County field is not active until you select a user group from the User Group field. You must enter data in the required fields to save the record. These required fields are noted in Table 8.

	Field
	Description
	Notes

	Contact Name
	Your user login name. 
	Required field.

	User Group
	Select the user group from the drop-down list. 
	Required field.

	County
	Select the county from the drop-down list. 
	Required field.

	School District
	Select the school district from the drop-down list. 
	Required field. 

This field is disabled for county office and county auditor user groups.

The field changes to SELPA AU for the SELPA user group.

	SELPA AU
	Select the SELPA Administrative Unit from the drop-down list.
	Required field.

This field only displays for a SELPA user group.

	School
	Select the school from the drop-down list.
	Required field for the charter school user group. This field is only active for a charter school user group.

	Phone
	Your telephone number. 
	Required field.

	Fax
	Your fax number.
	Optional field.

	E-Mail
	Your e-mail address.
	Optional field.


Table 8: New User Screen Fields

After you enter your information, click OK. If you did not enter data in a required field, a dialog box displays alerting you to the missing data. If you want to close the New User screen without saving the data you entered, click Cancel.

Once you click OK the Logon screen displays again with the new user you entered in the Please Select User dialog box.
4.2 Logging On

To log on and begin using the software after you have added a new user:

1. Select the user from the Please Select User drop-down list in the Logon screen.
2. Click the Logon button. The Main menu screen displays (Figure 5).
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Figure 5: Main Menu 
4.3 Getting The Latest LEA Updates

You can update LEA information (i.e., grade levels, new districts, or new schools) in the software database with a CDE-supplied text data file by clicking the Get Latest button in the Logon screen. The CDE will supply this file upon request. After you click the Get Latest button, the Importing Data for Get Latest screen displays Figure 6.
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Figure 6: Importing Data For Get Latest Screen

To get the updates:

1. Click Select File.

Note:
You can close the window without importing any data by leaving the field blank and clicking the Close button.

2. Select the text file in the Open window. 
3. Click Open.
The Open window closes and the file name and location displays in the text box in the Importing Data for Get Latest screen. The import process begins. A message box displays when complete. Click OK to view the Status Report. If you try to import a file with an invalid format, the Status window displays an error message. You can save, print, or close the Status window. 
4. Click Close.

4.4 Accessing Help

Clicking Help or pressing the F1 key from the Main menu or from any entry screen will link the user to the Principal Apportionment Data Collection page at http://www.cde.ca.gov/fg/sf/pa. Select the PADC Software Fiscal Year 2014–15 link to access the Resources and Documents for the current year (Figure 7). The following resources are available on this Web page to help a user with the submission of data: 
· What’s New – Summary of changes to the software from the prior year.
· Download and Installation Guide - Information on how to download and install the software.
· Software User Guide - Information on how to use the software and tips on how to print, save, export/import, etc.

· Data Reporting Instruction Manual - Information on how to use the data entry screens, where to report data, and description of data elements for each screen (previously known as the Help File). 

· Due Dates - List of Principal Apportionment Data Collection Software due dates for 2014–15 by entry screen.

· Contacts - List of program contacts for the Principal Apportionment by entry screen.
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Figure 7: Help 
4.5 Navigating Main Menus

The Main menu (Figure 5) is the starting point for entering data into the software.

The User Group selected when your account was created determines the Main menu screen appearance.

4.5.1 Main Menu Grids

There are two grids on every Main menu:

· LEA grid

· Entry Screens grid

The LEA grid displays information about the LEA(s). The columns are described in Table 9.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is “No.” Change the selection to “Yes” by clicking the SELECTED cell in the appropriate LEA row.

	COUNTY ID
	The county identification number.

	DISTRICT ID
	The district identification number.

	SCHOOL ID
	The school identification number. N/A for SELPA LEA.

	COUNTY NAME
	The county name.

	DISTRICT NAME
	The district name.

	SCHOOL NAME
	The school name, if any. N/A for SELPA LEA.

	DISTRICT TYPE
	The district type. N/A for SELPA LEA.

	SELPA NAME
	The SELPA name. For SELPA LEAs only.

	SELPA COUNTY
	The county in which the SELPA resides. For SELPA LEAs only.

	SELPA ID
	The SELPA identification number. For SELPA LEAs only.


Table 9: LEA Grid Information

The Entry Screens grid displays a list of screens that you can access to enter or view data. Each row contains information about entry screen data. The columns are described in Table 10.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is “No.” Change the selection to “Yes” by clicking the SELECTED cell in the appropriate entry screen row.

	ENTRY SCREEN NAME
	The entry screen name.

	CERTIFICATE NUMBER
	A unique number that is generated after data is entered and saved.

	NUM RECORD
	Number of records in the entry screen.

	NUM ERROR
	Number of errors in the entry screen.

	NUM WARNING
	Number of warnings in the entry screen.

	LAST MODIFIED DATE
	The date and time records in the entry screen were last modified and saved.

	LAST EDIT CHECK DATE
	The date and time the entry screen data was last saved and checked for errors. Not all screens are checked for errors, but the field still contains date and time information upon saving.

	LAST EXPORT DATE
	The date and time the entry screen data was last exported to a certified data file.

	LAST IMPORT DATE
	The date and time that certified data was last imported into the entry screen.


Table 10: Entry Screens Grid Information

4.5.2 Main Menu Commands

4.5.2.1 File Menu

The File menu contains the following commands shown in Table 11.

	Command
	Description

	Import
	The Import sub-menu allows you to import either ASCII (text) files or certified data files.

	Export
	The Export sub-menu allows you to export data to an ASCII (text) file or to a certified data file. 

	Print
	The Print sub-menu allows you to print various types of reports, depending on the software application you use and the user group selected. Please refer to Table 20 for more information.

	Printer Setup
	Opens a standard Windows Printer Setup window. You can select the printer to which you will print reports and the default number of copies you will print each time.

	Logout
	The Logout command logs the current user out of the application and returns to the Logon screen.

	Exit
	The Exit command closes the program and returns you to Windows.


Table 11: File Menu Commands

4.5.2.2 Period Menu

The Period menu allows you to switch between different reporting periods for the current fiscal year and for corrections. 

There are three reporting periods for the current fiscal year software 
(P-1, P-2 and Annual) and two reporting periods for corrections (P-1, P-2 and Annual). When you open the software for the first time, the default reporting period selected is P-1. Each time you reopen the software after that, it will always open to the last reporting period used.

Note:
A checkmark displays next to the selected period in the Period menu.

When reporting data for the current fiscal year, select a period by selecting P-1, P-2 or Annual from the Period menu. When reporting data for corrections, select Corrected from the Period menu, then select P-2 or Annual from the sub-menu. The list of entry screens available may change for the specific period.

4.5.2.3 LEA Menu

The User Group selected when the account was created determines the LEA menu choices. The LEA menu displays differently for county LEAs, school district LEAs, charter school LEAs, county auditors, and SELPAs.

Note:
The software automatically displays the LEA menu based on the User Group. 
4.5.2.4 Tools Menu

The options available in the Tools menu depend on the software being used and the user group selected. Table 12 displays a summary of the commands available by software:

	Command
	User Group
	Description

	
	SELPA
	County Auditor
	Charter

	School District
	COE

	

	User Information
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	The User Information screen displays your current user information and allows for modification to the contact name, telephone number, fax number, and e-mail fields. You cannot change your user group, county, school district, or school from this screen. You must create a new account if you want to change this information

	Contact Information
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	The Contact Information screen displays user information for lower-level LEAs. For example, Alameda county can access the user information for school districts and charter schools within the county, provided they have imported data from them.

	Necessary Small School Certification Selection
	N/A
	N/A
	N/A
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	County Offices of Education are required to certify the selection of schools for the application of the Necessary Small School Funding Model in accordance with Education Code Sections 42280 through 42285.3.

	Upload Certified Data
	N/A
	N/A
	N/A
	N/A
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	Sends the final certified data file to the CDE.


Table 12: Available Tools Menu Commands
4.5.2.5 Help Menu

The Help menu is a useful tool if you need assistance with a particular entry screen or program function. For more information on utilizing Help, see Section 4.4.

Clicking About displays the version number of the software, similar to the Logon screen. To return to the PADC Software, click OK. If you would like to view your Windows system information, click System Info. The System Information window displays information about your hardware, software, and Windows environment.

4.5.3 Selecting and Opening an Entry Screen

To select and open an entry screen:

1. Select the LEA by clicking the far left column of your selected LEA row in the top grid of the Main menu screen.

2. Open the entry screen by clicking the far left column of the entry screen row in the bottom grid of the Main menu screen. 
Note: 
If you cannot view the entire entry screen, use the vertical and horizontal scroll bars on the right and bottom sides of the screen, respectively. If your computer has higher video resolution, you may be able to resize your window so more of the entry screen displays.

When you open an entry screen that contains existing data, the data displays in the proper fields.

The data is entered into “cells.” Some cells may be disabled (grayed out). These disabled cells are used to show calculated values or to prevent a user from entering data that does not apply to them. Figure 8 displays a sample entry screen.
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Figure 8: Sample Entry Screen 
After adding a record you can enter data by typing the value into that field. If you have a fractional amount, you can enter that value by pressing the PERIOD key after you enter the whole number, and then type the two digit decimal amount. For example, if the amount is 230.25, type 230, press the PERIOD key, and then type 25. If you do not have a whole number value that precedes the decimal point, such as 0.75, press the PERIOD key first and then type 75.

4.5.3.1 Moving Through Fields

You can move to a different field in two different ways. You can press the TAB key to move the cursor to the next field, or you can move the mouse pointer over the field you want and then click the left mouse button. You can move to the previous field by pressing SHIFT+TAB. The program highlights the value in that field once the cursor displays there. If the next field does not display in the window, the program scrolls up or down the entry screen to display your selected field.

4.5.3.2 Entering Negative Numbers

Use the minus ( - ) sign before or after a number to enter a loss, or negative value, in an entry field. The value will then display in parentheses on the entry screen and on the corresponding report.

4.5.4 Selecting LEAs and Entry Screens for Printing and Exporting to
an ASCII (Text) File

You can choose either all or selected LEAs and entry screens for printing from the Main menu. You can choose either all or selected LEAs, but only one entry screen at a time for exporting to an ASCII (text) file from the Main menu.

To select all LEAs and entry screens for printing:

1. If only one row displays in the top grid of the Main menu, click the Selected column cell for that LEA row to change it to “Yes.” If more than one row displays in the grid, click the Select All button above the top grid. Each row in the top grid displays “Yes” in the SELECTED column.

2. Click the left arrow in the top grid. The Entry Screens grid (the lower grid in the Main menu) is now active.

3. Click the Select All button above the Entry Screens grid. Each row in the Entry Screens grid displays “Yes” in the SELECTED column. You can now print reports for all LEAs and entry screens that have data.

To select specific LEAs and entry screens for printing or exporting to an ASCII (text) file:

1. In the top grid of the Main menu, click the SELECTED column cell in each LEA row you want to print or export to an ASCII (text) file. The top grid displays “Yes” in the SELECTED column of each LEA row you click.

2. Click the cell to the left of any row in the top grid. The Entry Screens grid (the lower grid in the Main menu) is now active.

3. Click the SELECTED column cell of each program you want to print a report for or click the SELECTED column cell of one program to export to an ASCII (text) file. The Entry Screens grid displays “Yes” in the SELECTED column of each entry screen you select. You can now print reports for the selected LEAs and entry screens which have data, or export all selected LEAs and one entry screen that has data to an ASCII (text) file.

Note:
Deselect LEAs and entry screens by clicking the Deselect All button or by clicking the SELECTED column cell(s) of any LEA or entry screen to change the cell(s) to “No.”

4.6 Entering Data

This section explains how to use entry screen commands, add and delete records in entry screens that contain multiple records, and switch between tabbed and drop-down menus.

4.6.1 Entry Screen Commands

4.6.1.1 File Menu

The File menu displays the options shown in Table 13.

	Command
	Description

	Save
	Saves the entered data.

Note: A dialog box is displayed whenever you try to close an entry screen without saving the data. If you click No in the dialog box, the program discards the data and you cannot retrieve it. If you click Yes, the program saves the data and that data displays the next time you open the entry screen.

	Check/Save
	Runs a series of validations to determine if the saved data passes the edit check process. If there are errors, an edit check report displays (for more information about edit check reports, see Section 5.0).

Note: Not all entry screens have the Check/Save option enabled.

	Print
	The Print sub-menu allows you to print a report based on the data saved in the entry screen. After selecting Print, a print preview is displayed. From the print preview screen, you can print or export the report. The report will print using the default printer installed in your Windows application. All reports print on standard 8.5" x 11" paper. Each report displays the date and time of printing.

	Printer Setup
	Opens a standard Windows Printer Setup window. You can select the printer to which you will print reports, and the default number of copies you will print each time.

	Close
	Closes the entry screen and returns you to the Main menu.


Table 13: File Menu Commands

4.6.1.2 Note Menu

Selecting Add Note from the Note menu opens a window for creating and saving Notes to entry screens. Figure 9 displays a sample Notes window. Enter any relevant information in the text box provided and click Save. 
If you enter text into the Notes dialog box and then try to close the dialog box without saving, a dialog box displays and asks if you want to save the note. If you click No, the program discards the note and you cannot retrieve it. If you click Yes, the program saves the note and that note will display in the Notes dialog box the next time you open the dialog box. After you save your note and then save the data in the associated entry screen, you can view the saved note every time you access the Notes dialog box. The buttons are displayed in Table 14.
NOTE: Deleting data in the entry screen also deletes your note.
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Figure 9: Sample Notes Window 
	Button
	Description

	Save
	This button saves the note with your data. Every time you open the screen your note displays when you open the Notes dialog box. 

	Cancel
	Removes text that you entered after you opened the dialog box. If you saved text in the dialog box, the program does not remove that saved text.

	Delete
	Deletes all text in the Notes dialog box. When you click Delete a dialog box displays asking if you want to remove the text; when you click Yes the program deletes the text and you cannot retrieve it.

	Close
	Closes the Notes dialog box.


Table 14: Note Menu Buttons
4.6.1.3 Tools Menu (from an entry screen)
The Tools menu displays additional entry screen functions. For example, in the Taxes entry screen, a county auditor can use the Copy P-1 to P-2 option in the Tools menu to copy P-1 tax data to P-2. 
Note:
The Tools menu is only available in the Taxes entry screen and the Special Education Tax Allocation entry screen. 
The Help menu functions in the same manner as on the Main menu screen. Please refer to Section 4.4 for more information on utilizing Help.

4.6.2 Entering Data into Single Record Entry Screens

Some entry screens only allow one record to be created for the selected LEA (Figure 10).
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Figure 10: Sample Single Record Entry Screen 
In single record entry screens, the Save, Check/Save, Delete, Cancel, and Close buttons are displayed.

Note:
The Check/Save button is not available in all entry screens.

4.6.3 Entering Data into Multiple Record Entry Screens

Some entry screens allow multiple records to be created (Figure 11). You can tell the screen is for multiple records because at the bottom of the screen it shows “X of X” and has “Add New” button to add another record.
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Figure 11: Sample Multiple Record Entry Screen

Select an existing record, add a new record, or delete the currently selected record by clicking on one of the following buttons as shown in Table 15.

	Button
	Description
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	Moves to the first record.
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	Moves to the previous record.
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	Moves to the next record.
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	Moves to the last record.
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	Adds a new record.
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	Deletes the currently selected record.


Table 15: Multiple Record Entry Screens Navigation Buttons

4.6.3.1 Adding Records

To add a record to the screen:

1. Click on the Add New button. The Add New Record screen displays, similar to the one shown in Figure 12.
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   Figure 12: Sample Add New Record Screen 
Choose the LEA you want to enter data for, and then click on the Add Record button. You can now enter data for that LEA. Figure 13 shows an entry screen after completing the Add New record entry screen.
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Figure 13: Sample Entry Screen After Adding A New Record

2. Click Save to save the record. 

3. Add additional records by following steps 1-3.

4.6.3.2 Deleting Records

To delete a record:

1. Select the record you want to delete.

2. Click on the Delete button.

3. Click Yes in the Delete dialog box.

4.6.3.3 Selecting and Searching for Records

If you want to open a saved record in the entry screen, you can select an existing record by using the buttons described in Table 15. 

Some entry screens have an additional search feature ([image: image206.png]


). For example, you can search for records in the Class Size Penalties entry screen by following these steps:

1. Enter the average class enrollment size you want to search for into the text box at the lower left corner of the entry screen.

2. Click the search button ([image: image207.png]


). The first record with the enrollment size you entered in the text box displays in the entry screen. You can search for the next record that contains the enrollment size (for Less Than Full Second Period selection) by clicking the search button ([image: image208.png]


) again.

A dialog box displays when you reach the last record or if the record was not found.

4.6.4 Switching Between Tabbed and Drop-Down Menus

Each entry screen contains one or more tabs. These tabs display in a row at the top of the screen (Figure 14).
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Figure 14: Entry Screen Tabs

If an entry screen has more than one tab, you can move to each entry screen by clicking on the tab. After you click the tab the screen for that tab displays.

At the end of the tab row the Drop-Down menu button ([image: image210.png]


) displays. When you click this button the tab menu changes to a drop-down text box showing the name of the currently selected tab with a drop-down arrow on the right. The Drop-Down menu button changes to the Tabs button (Figure 15).
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Figure 15: Entry Screen Drop-Down Menu

You can view each tab by clicking on the drop-down arrow and then selecting a screen from the drop-down list. You can revert back to tab view by clicking on the Tabs button ([image: image212.png]


).

4.7 Resizing Windows

You can resize a window by moving your mouse pointer to an edge or the corner edge of the window. The pointer changes into a two-sided vertical arrow when the pointer is moved over the top or bottom edge, a two-sided horizontal arrow when the pointer is moved over the left or right edge, or a two-sided diagonal arrow when the pointer is moved over a corner edge. Then you can hold down your left mouse button and move the mouse to shrink or enlarge the window size.

5.0 Edit Check Reports

After data is entered, users should run a validation process on their data. This section describes how to perform the edit checks.

Note: Not all entry screens have the Check/Save option enabled.

To check your data for errors:

1. Enter data into the entry screen.

2. Click the Check/Save option or button, if available. The program saves your data and checks it to ensure that no errors exist. If no errors exist, a dialog box displays to inform you that the data have passed the error check process (Figure 16).
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Figure 16: Edit Check Process Message Box

If an error does exist, an Edit Check report displays the error as shown in Figure 17.
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Figure 17: Sample Edit Check Report

The Edit Check Report displays a table listing fields that contain invalid data. Table 16 describes the information in each column.

	Column
	Description

	Line No
	The line number and column (A or B) in the entry screen that contains the erroneous field.

	Field Caption
	The name of the field.

	Type
	The error severity type: E (error) or W (warning). An error with type E is a fatal error, and you will not be able to certify and export the data until you fix the problem as stated in the Message column. A type W error is a warning that reminds you about possible errors or problems in the entry screen. Warnings do not affect your ability to certify and export the data.

	Message
	The message in this column instructs you how to rectify the error.


Table 16: Edit Check Report Information

The Edit Check screen contains the following functions as shown in Table 17.

	Button/Function
	Description

	[image: image215.png]


 
	Sends the report to the printer.
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	Exports the report into an HTML or ASCII (text) file.
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	Sets the magnification level from the drop-down list.
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	Moves to the first page in the report.
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	Moves to the previous page in the report.
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	Moves to the next page in the report.
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	Moves to the last page in the report.


Table 17: Edit Check Screen Functions

3. Click OK to close the edit check passed message box, or click [image: image222.bmp] to close the Edit Check Report. 

4. Make the necessary corrections in the entry screen until there are no fatal errors.

5. Close the entry screen.

6.0 Correcting Data from a Prior Period

If you need to submit corrected data for prior P-2 or Annual reporting periods, you can input corrected data by selecting the Period menu, then selecting P-2 or Annual from the Corrected sub-menu.

If you have not yet submitted data or need to correct data and the cutoff period has recently passed, contact CDE to determine if an original (non-corrected) file may still be accepted.

Note: 
You must use the appropriate fiscal year software to make corrections. For example, you would use the 2013-14 software in fiscal year 2014-15 to make the 2013-14 corrections. Any data that is changed replaces previously saved data.

6.1 Corrected Period Main Menu

When you log in and select a corrected period from the Period menu, the Main menu displays the CORRECTED columns shown in Figure 18.
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Figure 18: Main Menu Screen For Corrected Periods 
The LEA grid columns in a corrected period’s Main menu are described in Table 18.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate LEA row.

	CORRECTED
	Denotes whether corrections have been made. The default selection is No.

	COUNTY ID
	The county identification number.

	DISTRICT ID
	The district identification number.

	SCHOOL ID
	The school identification number. N/A for SELPA LEA.

	COUNTY NAME
	The county name.

	DISTRICT NAME
	The district name.

	SCHOOL NAME
	The school name, if any. N/A for SELPA LEA.

	DISTRICT TYPE
	The district type. N/A for SELPA LEA.

	SELPA NAME
	The SELPA name. For SELPA LEAs only.

	SELPA COUNTY
	The county in which the SELPA resides. For SELPA LEAs only.

	SELPA ID
	The SELPA identification number. For SELPA LEAs only.


Table 18: LEA Grid Columns For Corrected Periods

The Entry Screens grid columns for corrected periods are described in Table 19.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate entry screen row.

	ENTRY SCREEN NAME
	The entry screen name.

	CORRECTED
	Denotes whether corrections have been made to the data in the entry screen. The default selection is No.

	REASON CODE
	The reason code for the correction.

	CERTIFICATE NUMBER
	A unique number that is generated after data is entered and saved.

	NUM RECORD
	Number of records in the entry screen.

	NUM ERROR
	Number of errors in the entry screen.

	NUM WARNING
	Number of warnings in the entry screen.

	LAST MODIFIED DATE
	The date and time the entry screen was last modified and saved.

	LAST EDIT CHECK DATE
	The date and time the entry screen data was last saved and checked for errors. Note: Not all entry screens have the Check/Save option enabled.

	LAST EXPORT DATE
	The date and time the entry screen data was last exported to a certified data file.

	LAST IMPORT DATE
	The date and time that certified data was last imported into the entry screen.


Table 19: Entry Screen Grid Columns For Corrected Periods

6.2 Correcting Data

To correct data after the cut-off date:

1. Select Corrected from the Period menu.

2. Select the period (P-2 or Annual) you want to correct from the Corrected submenu. The list of entry screens in the Entry Screens grid changes to reflect the screens available to correct for the selected period and LEA type.
3. Select the LEA in the top grid to activate the Entry Screens grid.

4. Open the entry screen to correct and make any necessary changes to the data.

Note:
Data entered in the standard P-2 or Annual reporting periods will be displayed in the entry screen fields.

5. Click Save or Check/Save.

Note:
Remember to click Check/Save (if available) to ensure the entered data passes the edit check process.

6. Click Close to close the entry screen.

7. Upon closing the entry screen, the Correction Reason dialog box displays as shown in Figure 19.

Note:
The Correction Reason screen will not display unless data (original or corrected) has been saved in the entry screen.
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 Figure 19: Correction Reason Screen 
8. Select the reason for the correction from the Correction Reason drop-down list.

9. Type correction notes in the Correction Notes text box.

Note:
You must enter notes in this text box. Do not leave the text box blank.

10. Click Close. The Correction Reason screen closes and the Main menu displays.

Note:
In the Entry Screens grid, the CORRECTED column displays “Yes” and the correction reason selected is displayed in the REASON CODE column. In the top grid, the CORRECTED column for the LEA row that was corrected displays “Yes.”

Once the CORRECTED column displays “Yes,” you can re-enter the Correction Reason dialog box by clicking the “Yes” in the CORRECTED column cell in the Entry Screens grid if you need to edit the correction reason or notes.

6.3 Saving Data in P-2 and Annual Reporting Periods

Any data that is changed and saved replaces previously saved data. If you change and save P-2 or Annual corrected period data, the data changes OVERWRITE the previously saved P-2 or Annual period data. Conversely, if you change and save P-2 or Annual data in the “standard” (meaning from the Period menu, not from the Period menu’s Corrected sub-menu) reporting period, the saved changes overwrite any existing P-2 or Annual corrected period data.

For instance, suppose you saved and submitted P-2 data in the standard reporting Period menu. After CDE has processed the file, if you discover an error and want to change (correct) the data and resend it, you select 
P-2 from the Period menu’s Corrected sub-menu and enter data for the same LEA. In this case, if you save the corrected data, it will replace the P-2 data you originally entered in the standard P-2 period.

7.0 Importing and Exporting

Once data is entered, it can be exported to a file and/or imported to another program. This section describes how to import and export data files and send those files to the CDE.
7.1 Importing Data Files

7.1.1 Importing ASCII Files

You can import data into the program from a properly formatted ASCII (text) file. When opened in Notepad, a properly formatted ASCII file displays each entry screen’s table name (as used in the software) and entry field names on one line. Beneath this line, an additional line exists for each record in the entry screen. These additional lines display the entry screen’s table name, and the actual data in each entry field. Data must be in the proper sequence and format to be imported. 

To import an ASCII (text) file from the Main menu screen:

1. Click Import from the File menu.

2. Click ASCII File in the submenu. The Importing ASCII Data screen displays (Figure 20).
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Figure 20: Importing ASCII Data Screen

3. Click Select File and select the file you want to import.

4. Click Open.

After the program imports the file, the Status window displays the results of the import process showing the number of records skipped, copied, and overwritten. You can save, print, or close the Status window. You can close the Importing ASCII Data screen without importing any data by leaving the field blank and clicking Close.

Note:
If the program cannot import the file, a dialog box will display and inform you. If data already exists in the record you are importing data into, one or more dialog boxes display that ask if you want to overwrite the data. If you continue to have problems with the ASCII files, please refer to the Known Problems, Fixes, and Work Arounds document at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp.
7.1.2 Importing Certified Data Files

You can import a certified data file into the program.

To import a certified data file from the Main menu screen:

1. Click Import from the File menu.

2. Click Certified Data in the submenu. The Importing Certified Data screen displays (Figure 21).
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Figure 21: Importing Certified Data Screen

3. In the Importing Certified Data screen, click Select File.

4. Select the file you want to import.

5. Click Open.

After the program imports the file, the Status window displays the results of the import process showing the number of records skipped, copied, and overwritten. You can save, print, or close the Status window. You can close the Importing Certified Data window without importing any data by leaving the field blank and clicking Close.

Note:
If the program cannot import the file, a dialog box will display and inform you. If data already exists in the record you are importing data into, one or more dialog boxes display that ask if you want to overwrite the data.

7.2 Exporting Data Files

7.2.1 Selecting Data to Export

You can export entry screen data to an ASCII (text) file or a certified data file, but first you must select data to export. The process for selecting data depends on whether you want to export an ASCII (text) file or certified data file.

7.2.1.1 Selecting LEAs and Entry Screens for Exporting to an ASCII (Text) File

For more information on selecting data to export to ASCII (text) files, please see section 4.5.4.

7.2.1.2 Selecting LEAs and Entry Screens for Exporting to a Certified Data File

Access the Export Certified window by selecting Export from the File menu, then selecting Certified Data from the sub-menu.

You can select all LEAs and entry screens, or individual LEAs and entry screens for data export to a certified data file by using the Export Certified window (Figure 22).
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Figure 22: Export Certified Window

Note:
The Export Certified window will display differently depending on your user group type.

The Export Certified window displays two panes. The left pane displays a tree view of all LEAs, and the right pane displays a tree view of all available entry screens. 

Selecting checkboxes in each pane automatically selects each branch of the tree. For example, selecting the District(s) checkbox in the left pane automatically selects each school district in the county (Figure 23).
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Figure 23: Export Certified Window With All Districts Selected

Click the “+” sign to view all items in each LEA or program. Click the “-” sign to hide the items.

To select all county, district, and charter school LEAs for export, select the checkbox to the left of LEA(s) (at the top of the left pane). To select all county, district, and charter programs for export, select the checkbox to the left of Program(s) (at the top of the right pane). SELPA LEAs and programs must be selected separately.

To select individual LEAs and entry screens, navigate through the left and right panes and select the checkbox beside each LEA and entry screen you want to export. 

7.2.2 Exporting ASCII Files

You can export data to an ASCII (text) file for internal distribution.

To export entry screen data into an ASCII file:

1. Select the LEA(s) and entry screen you want to export (see Section 4.5.4).

2. Click Export from the File menu.

3. Click ASCII File in the submenu. The Save As window displays.

4. Navigate to a folder and enter the file name in the File name field or accept the default folder and file name.

5. Click Save. The Status window displays.

6. Save, print, or close the Status window.

7.2.3 Exporting Certified Data Files

You must export the data you entered in the program to a certified data file to send to the CDE by the filing dates. You can export Selected Certified Data or All Certified Data.

7.2.3.1 Exporting Selected Certified Data

To export Selected Certified Data:

1. Click Export from the File menu.

2. Click Certified Data in the submenu. The Export Certified window displays.

3. Navigate through the Export Certified window and select the checkbox beside each LEA and entry screen you want to export. When making selections, appropriate combinations of LEAs and Programs must be selected. For example, if only the Charter School(s) box is selected in the left pane, and a County Offices of Education Program is selected in the right pane, an error message will display. (For more information on selecting LEAs and programs, see Section 7.2.1.2).

4. Click Export. The Data Modification window displays.

5. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions. (For more information on Data Modification, see Section 7.2.3.3). 

6. Click OK. The Status window displays. 

7. Note: You can save, print, or close the Status window.

8. Close the Status window.

9. Close the Export Certified window by clicking the Cancel button.

Note:
If you get an error in your Export Status window, check the Entry Screens grid to ensure that the date and time in the LAST EDIT CHECK DATE column is the same or later than the date and time in the LAST MODIFIED DATE column. The entry in the LAST MODIFIED DATE column only indicates when you last saved the data, not the last time you checked the data for errors.

10. In the Entry Screens grid, the export date and time is displayed in the LAST EXPORT DATE column in the entry screen row.

7.2.3.2 Exporting All Certified Data

To export All Certified Data:

1. Click Export from the File menu.

2. Click Certified Data in the submenu. The Export Certified window displays.

3. Select the LEA(s) checkbox in the left pane of the Export Certified window. A check mark is displayed in the check box.

4. Select the Program(s) checkbox in the right pane of the Export Certified window. A check mark is displayed in the check box.

Note:
Because there may be different due dates for an entry screen, you should expand the county and district trees in the right pane and only check the appropriate program box when exporting data for the CDE. A list of due dates by entry screen is available at http://www.cde.ca.gov/fg/sf/pa/padcsw1415.asp under the Resources and Documentation header.
5. Click Export. The Data Modification window displays.

6. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions. (For more information on Data Modification, see Section 7.2.3.3).

7. Click OK. The Status window displays.

8. Close the Status window. 

Note:
Because a SELPA AU type logon differs from other LEAs, two export files must be completed if SELPA data is present. One file containing all county, school district, charter school and tax data must be prepared, and one containing only SELPA data must be prepared.

9. Close the Export Certified window.

Note:
If you get an error in your Export Status window, check the Entry Screens grid to ensure that the date and time in the LAST EDIT CHECK DATE column is the same or later than the date and time in the LAST MODIFIED DATE column. The entry in the LAST MODIFIED DATE column only indicates when you last saved the data, not the last time you checked the data for errors.

10. In the Entry Screens grid, the export date and time is displayed in the LAST EXPORT DATE column in the entry screen row.

7.2.3.3 Data Modification

The Data Modification window (Figure 24) must be used to explain any changes you have made to data that you are submitting. The Data Modification window is user group specific, e.g. the questions and certification language are different depending on user group type.
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Figure 24: Sample Data Modification Window

This window must be completed before the export file creation process will begin.

1. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions.

2. Click OK after answering all of the questions. The export process will commence.

3. Upon completion, a status window will display with details on the data exported.

4. You can then print a Certification Exception Report for your records. (For more information on printing a Certification Exception Report, see Section 9.2).

8.0 Submitting Certified Data Files

8.1 Sending Certified Files to the COE
This section only applies to school districts, charter schools, county auditors, and Special Education Local Plan Areas (SELPAs).

After you export your data to a certified data file, send the certified file to your school district or COE.

For example, a charter school user will enter their data into their entry screens, export their certified data to a certified data file, and send the export file to their school district. The district will import the file(s) received from their charter school(s). The district will also enter their data into their entry screens. The district will export all the data (district and charter) to a certified data file, and send the export file to their county.

E-mail makes the submission process quick and easy; however, you must also submit your signed certification page(s) to your district or COE. 

Your Internet Service Provider (ISP) may have attachment size limits, so ensure that e-mail attachments do not exceed the size limit. Contact your ISP for more information.

8.2 Uploading Certified Data

This section only applies to a COE.

After a COE exports all of their files and any files received from their LEAs to a certified data file, COEs must send the certified file to CDE via File Transfer Protocol (FTP). The Principal Apportionment Data Collection software contains an FTP component. 

Additionally, the County Superintendent must sign the Certification page(s) submitted from their district(s) and/or charter school(s) and keep them on file.

To upload a certified data file:

1. Select Upload Certified Data from the Tools menu. The Submit Datafile window displays (Figure 25).
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Figure 25: Submit Datafile Window

2. Enter the COE password and click Select File. The Select Datafile to Submit window displays (Figure 26). 
Note:
The COE password was incorporated into the PADC software and issued to the COE in the 2004-05. The COE password is specific to each county office of education. If the password is lost or not working, please send an e-mail from the County Superintendent or chief business officer to PASE@cde.ca.gov. 
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Figure 26: Select Datafile to Submit Window
Note:
If you cannot see the Export file, the exported files could be in the Virtual Export folder. To see the files in the Virtual Data Export, click “Compatibility files” for the Export folder you want to view. After displaying the Virtual Export folder, you will be able to see the files in the Export folder. You can then copy/paste the export file to another location. You may need to use Ctrl V to paste the export file(s) into an e-mail.

Note:
If the password is not entered, the Enter Password message box displays (Figure 27).

[image: image232.png][ L —





Figure 27: Enter Password Message Box

Note:
If the incorrect password is entered, the Incorrect Password message box displays (Figure 28).
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Figure 28: Incorrect Password Message Box

3. Select the file to submit and click Open. The Uploading Confirmation message box displays (Figure 29).
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Figure 29: Uploading Confirmation Message Box

4. If the correct file name is displayed in the message box, click Yes. When the upload process is complete, a Status window displays showing the results of the upload process. 

Note:
The data file name must begin with the type of software used to create the file. An example of a valid data file name would be PADCSV14_00_1_01_Nov_20_2014_14_33_32
5. Click Close to close the Status window. (Figure 30)
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Figure 30: Operation Complete Status Window
6. Click Close to close the Submit Datafile window.

9.0 Printing Data

Reports can be printed from any entry screen and the Main menu using the software’s Print utility. Before you print reports, you should set up your printer.

From the File menu, select Printer Setup to open a standard Windows Printer Setup window. You can select the printer to which you will print reports, and the default number of copies you will print each time.

9.1 Printing Reports from an Entry Screen

Each individual entry screen has a report associated with it. The reports display in the Print Preview window.

To print an entry screen report:

1. Open the entry screen.

2. Select Print from the File menu. The Print Preview window opens.

Note:
To view more of the report on-screen you can resize the window, or select a zoom percentage from the Zoom drop-down list.
Click the navigation ([image: image236.png]Wl



) buttons to scroll through the pages of the report.

3. Click the Print button ([image: image237.png]


). The Print dialog box opens.

4. Click OK. The report is sent to the printer.

5. Click the Close button (() to close the Print Preview window.

9.2 Printing Reports from the Main Menu

Before you print from the Main menu, you must select the LEA(s) and the entry screen(s) to be printed. For more information on selecting LEAs and entry screens, see Section 4.5.4. The available reports you can print depend on the software application you are using and the user group selected. Table 20 lists all software reports you can print from the Main menu for each user group.

	Available Reports
	Reports
	Certification
	Blank Certification
	COE Certification
	Certification Exception (County, District, Charter, Auditor and SELPA)
	LEA Status Report (Attendance and SELPA)

	Tax Software User Group

	County Auditor
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	Data Collection Software User Groups

	County Office
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	School District
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	Charter School
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	County Auditor
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	SELPA
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Table 20: Available Software Reports For Printing (by user group)

Table 21 describes each type of printed report.

	Report Type
	Description

	Reports
	Prints data reports for selected LEA(s) (from the top grid) and entry screen(s) (from the Entry Screens grid).

	Certification
	Prints a certification page for selected LEA(s) and entry screens so you can get the proper signatures.

	Blank Certification
	A blank certification page can be printed and sent to an LEA that is not using the software to enter their data but is having their school district, COE, or other governing agency enter it for them. In these cases, the governing agency must send a blank certification page to the lower-level LEA so they may sign the certification page.

	COE Certification
	Prints a single Certification page for a selected program that lists the certification number for each LEA in the county that submitted data for that program rather than printing a separate certification page for each LEA.

	Certification Exception

(County, District, Charter, Auditor, and SELPA available from Sub-Menu depending on user group)
	Displays the questions and answers from the Data Modification dialog box that opened when you exported certified data. (For more information on Data Modification, see Section 7.2.3.3.) 

	LEA Status Report

(Attendance and SELPA available from Sub-Menu depending on user group)
	Depending on the report selected, displays a report that shows the number of records for each program for which you have data, sorted by LEA.


Table 21: Principal Apportionment Software Printed Report Descriptions

After you print the reports, the Status window displays the success or failure of the printing process. You can save the status report by clicking the Save button, or print the status report by clicking the Print button. Close the Status window by clicking the Close button.
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